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1. Beeper Duties.

The duty cell phone, pager and laptop change hands at 8am on Monday. MAC laptop is

available for responding to earthquake alarms and for weekend/holiday checks from outside the

Lab. You have to have high-speed internet access to be able to do that.

The AEIC duty responsibilities include:

- respond to earthquake alarms

- perform quality control of automatic event locations

- release felt events regardless of magnitude

- check data flow and system health over the weekend/holidays

- check and respond to AEIC voice-mail messages (474-4300)

The beeper duty person should be present in the Lab during regular business hours and

perform event checks at least every half hour. If you are on duty but can not be present in the Lab

to monitor automatic event locations, you have to find someone to take care of the event quality

control and updates and information releases in your place.

2. Weekend/Holiday Duties.

The beeper duty person must perform weekend and holiday checks either by coming into

the Lab or through duty laptop as follows:

(1) Review automatic locations with duty_dbevents. Relocate and release as needed Ml >3.5 in

region A or Ml >4 region B, or those that are grossly mislocated, regardless of magnitude. If

there are no automatic locations within the past 12 hours - call Mitch Robinson or Natasha

Ruppert.

(2) Check the data flow. If in the Lab, look at the computer displays in the computer room

(SCREAM PCs and large display with the waveforms scrolling across, next to the earthquake

map). If there are no waveform data being shown on SCREAM PCs and/or vast amounts of

data (e.g., more than half of the stations) are missing on the scrolling waveform display - call

Mitch Robinson or Steve Estes. From outside the Lab, check recenteqs page. If there are no

earthquakes within the past several hours, you need to come into the Lab to make sure the data

is being recorded.
Last update 02/26/2008 by N.Ruppert.
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3. AEIC Earthquake Alarms.

Our goal is to respond to potentially damaging earthquakes and/or events that can be felt

by significant number of people. Earthquake alarms are generated by orb_quake_alarm program

(see man page for details). This program continuously monitors automatic locations in summary

database on kobuk computer. Whenever parameters of an origin (magnitude, location, and number

of phases) satisfy the alarm criteria, a text message is sent to the duty cell phone. This message

contains alarm ID number (alarmid) and event ID number (evid) in the subject line. The body of

the message contains the following information: magnitude, depth, number of phases, nearest

population center, origin time. In case when this alarm is not cancelled within 3 min, a duplicate

message is sent to the duty pager. If alarm is not cancelled within 10 min, the same text message is

sent to Roger Hansen’s cell phone. See “Earthquake Alarm Procedural Check List” for detailed

description of how to cancel the alarm.

Currently, alarms are generated for origins with at least 15 associated phases and:

- M>=3.5 within 0.5 degree radius (~50 km) of Fairbanks, Anchorage and Juneau;

- M>=3.8 in the region that includes Matanuska-Susitna valley, Kenai, and Prince William Sound

communities;

- M>=4.0 in the rest of the mainland Alaska, including the southeast region;

- M>=5.0 in the Aleutians.

Exact polygons for the above-mentioned regions are given in

/Seis/databases/regions/alarm_regions database. The alarm trigger parameters can be found in

/iwrun/sum/run/pf/orb_quake_alarm.pf parameter file. See also map below.
Last update 02/26/2008 by N.Ruppert.
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4. Felt Events.

Earthquake Hazard program at USGS maintains a website for reporting felt earthquakes.

If you look at http://pasadena.wr.usgs.gov/shake/ak/ you will see a list of events for Alaska. These

links are automatically generated only for 4.5 and above earthquakes located anywhere in Alaska

and the Aleutians and 3.8 and above in or near Alaska’s main population centers. If event is not

listed in this table, a person can fill out a questionnaire for unknown event. In this case an e-mail

message is sent to several recipients including AEIC beeper duty personnel. These messages

come from Shake Account. Look at the time of the reported shaking and compare it to the list of

our automatic locations (you need to convert local AK time into UTC). If there is an event within

a reasonable time of the reported shaking, then this event needs to be released. Beware of bogus

felt reports, not all are real. DYFI page is also useful to check for felt reports to include into the

information release.

Example of an e-mail message from Shake Account:

*********************************************************************

Date: Fri, 24 Feb 2006 20:09:52 -0800 (PST)

From: Shake Account <shake@ciim-pas.gps.caltech.edu>

To: wald@usgs.gov, vinceq@usgs.gov, alarm@kiska.giseis.alaska.edu, wcatwc@noaa.gov,

felt@neis.cr.usgs.gov, duty@giseis.alaska.edu

Subject: CIIM Unk. (Glennallen, AK) I=3.4 (III)

T_Submit: Feb 24 2006 20:09:24 PST <Note: Time when this felt report was submitted>
T_User: Feb 24 2006 6:50 PM (local) <Note: Time when the shaking was felt>
Name: Lee Bauke(baukeL@alyeska-pipeline.com)907-320-1117--

Location: ZIP 99588 (Glennallen, AK) Region AK

Street: MP 186.5 Glenn Hwy (cross-st: Glennallen & Richardson intersection)

-----

User CDI: 3.4 (III)

Location: Apartment

Were you asleep? No

Felt it? Yes

Others felt it? No answer

Describe motion: Moderate

Duration (s): 10

Your reaction: Very little

How did you respond? if it had lasted any longer i would have moved to a doorway

Creaking noises? Yes slight

Damage: none

comments felt like a rolling earthquake, shook the house and there was some creaking.

*********************************************************************
Last update 02/26/2008 by N.Ruppert.
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5. Guidelines for Reviewing and Releasing Events.

(1) Always review alarm events.

(2) In addition to alarm events, review (relocate) automatic events:

- with automatic magnitude M > 3.5 in the mainland Alaska and as far south as the Kodiak

Island and including the southeast Alaska (referred to as Region A);

- with automatic magnitudes M > 4 south-west of the Kodiak Island, along the Alaska Penin-

sular and the Aleutian arc (referred to as Region B);

- mislocated events.

(3) Full RELEASE: From the origin table menu select Edit-> Respond

- if the reviewed event has Ml > 3.5 in region A;

- if the reviewed event has Ml > 4 in region B;

- if the event was felt, regardless of the magnitude and location.

(See “7.1. Response Procedural Checklist” for detailed description of the information release

procedures).

(4) UPDATE (partial RELEASE): From the origin table menu select Edit -> Update

- if the reviewed location has Ml<3.5 in the region A or Ml<4 in the region B.

      (See “AEIC Response Software Documentation” for a detailed description of the Partial

release/Update procedures).

(5) Special provisions can be made for intense aftershock sequences, such as increasing magni-

tude thresholds for releases. Consult with lead seismologist regarding this.
Last update 02/26/2008 by N.Ruppert.
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6. Quality Control of Automatic Events.

This is a very important task. Real-time event locations are distributed to a number of

recipients including AEIC and ANSS web pages, State Emergency Services, TAPS monitoring

systems, ShakeMap triggering module, etc. The duty person is responsible for providing quality

control of automatic locations, i.e. mislocated earthquakes should be relocated and false events

deleted (for example, locations based on telemetery glitches).

(1) Always have the following program running with audio on while in the Lab:

duty_dbevents

This program displays seismic events and waveforms in real time (see dbevents man page

for more information). This is an interactive program that allows you to monitor automatic events,

send a “delete message” to remove bad locations and to relocate events when necessary. Cur-

rently, the quake database is the so-called summary database that includes our internal automatic

and analyst reviewed locations and external reviewed locations from ATWC and NEIC. Reviewed

events have flag “r” in the event list. When on duty, ignore these events. The only exception are

the NEIC and ATWC reviewed locations. These events have higher priority over our automatic

locations and listed with 0 associated phases. These still need to be reviewed if satisfy the criteria

(1) or (2) on the previous page.

Note: Events in the duty_dbevents window may be listed out of the sequence; they are

sorted by time they were added to the database, not by the earthquake origin time.

To delete an event: R-click on the event location on the map and choose “Delete event ...”

option. To relocate an event, choose “Review event” option.

(2) Keep an eye on ANSS webpage with Alaskan earthquakes and our own dbrecenteqs page. If

these pages do not receive any new earthquakes report it to Mitch Robinson.

earthquake.usgs.gov/recenteqs/recenteqsus/Maps/special/Alaska.php

http://www.aeic.alaska.edu/recent/sub/index.html
Last update 02/26/2008 by N.Ruppert.
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7.1. Earthquake Alarm Response Procedural Checklist.

This document outlines a procedural checklist for AEIC earthquake alarm response. In this paper,

double quotes indicate a button or menu option, and mouse clicks are assumed to be a left mouse

click unless noted. Blue text indicates a program. This outline is in 6 parts:

I. CANCELLING ALARM

II.A. BEGIN THE ALARM RESPONSE - FROM THE LAB

II.B. BEGIN THE ALARM RESPONSE - FROM OUTSIDE THE LAB THROUGH DUTYLAP

III. LOCATE THE EVENT

IV. CHECK FOR FELT REPORTS

V.A. CREATE THE RELEASE IN THE LAB

V.B. CREATE THE RELEASE THROUGH DUTYLAP

VI. RELEASE DISTRIBUTION

I. IMMEDIATELY UPON RECEIVEING THE EARTHQUAKE PAGE:

(Step 1a) You must cancel the alarm. This is done via text messaging with the cell phone or by

sending e-mail message. Look at the text message with automatic location and remember

alarm ID number that is included in the subject line (alarmid).

Cancelling via e-mail message:

Address this message to seissum@giseis.alaska.edu. Type ‘ack’ in the subject line and ‘ack

alarmid’ in the body of the message, where alarmid is the alarm ID number. Send the mes-

sage. The cancellation program will recognize messages sent from any of the giseis or gi
accounts. If you have a private e-mail account that you would like to use for the alarm cancel-

lations, it has to be included into the mail parser parameter file. Talk to Natasha Ruppert if you

want to add your home e-mail account to the list of accounts authorized to cancel alarms.

Cancelling via text messaging:

- Reply to incoming alarm text message from seissum@giseis.alaska.edu with typing in the

message body “Ack ###” where ### is the alarm number.

- Press “Send”.

- You’re done cancelling the alarm.

 If alarm has been successfully cancelled, a text message will be send to the duty cell phone with

the acknowledgment of your acknowledgment. It comes from seissum with subject line:

‘Acknowledgment for alarmid XX’, and body of the message: ‘Cancelled by
9073222014@msg.acsalasks.com at TIME UTC’.

(Step 1b) If you don’t have duty laptop and internet access, you need to drive to the lab to do a

release. You may optionally call 474-7320 to see if anyone is in the lab to do a release for you.

This can save unnecessary driving. While on duty, you should remain within 15 minutes of the

seismology lab.
Last update 02/26/2008 by N.Ruppert.
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II.A. BEGIN THE ALARM RESPONSE - FROM THE LAB:

(Step 2a) Choose an appropriate workstation to process the earthquake. Due to e-fax settings, it

has to be either your main working station or alarm station. Login and start duty_dbevents
from the command line on the monitor that you are using to launch dbloc2.

(Step 2b) Find your alarm event on the map, right click on it and choose “Review event” option.

“Response” window will appear.

(Step 2c) Click on “Subset database & Relocate event” button. Note: if you are reviewing event

with NEIC location, you need to type in a different orid at the top of the “Response” window.

All origins for the given event are listed in the bottom right panel of the duty_dbevents win-

dow. Choose an automatic orid with decent number of associations. You are then asked to

delete a tmp directory. Click “Delete” without fear. Dbloc2 will then start.

II.B. BEGIN THE ALARM RESPONSE - FROM OUTSIDE THE LAB THROUGH DUTYLAP

(Step 2a) Turn on the duty laptop. Make sure it is connected to the internet. Log in as alarm (pass-

word ).

(Step 2b) Click on VPNClient icon in the upper right corner of the screen. Double-click on the GI

entry or click on “Connect” icon. Log in with your Lab network username and your Banner

ID as the password. If this fails, log in with the username and password that you use for your

on-line time-sheet submissions. You may now minimize VPN Client window.

(Step 2c) Click on X11 icon in the upper right corner of the screen. xterm window will appear. In

this window type:

ssh -YC tele.giseis.alaska.edu -l dutylap
Alternatively, you can copy and paste this command from help file that sits on the desktop.

Type in the password ( ). You are now logged into the seislab network. From now

on, the response procedure is very similar to II.A.

(Step 2d) Start duty_dbevents by typing it in the xterm window.

(Step 2e) Find your alarm event on the map, right click on it and choose “Review event” option.

“Response” window will appear.

(Step 2f) Click on “Subset database & Relocate event” button. Note: if you are reviewing event

with NEIC location, you need to type in a different orid at the top of the “Response” window.

All origins for the given event are listed in the bottom right panel of the duty_dbevents win-

dow. Choose an automatic orid with decent number of associations. You are then asked to

delete a tmp directory. Click “Delete” without fear. Dbloc2 will then start.

III. LOCATE THE EVENT:

(Step 3a) Locate the event using the appropriate software. Dbloc2 is the standard locating soft-

ware. Reference the guide “A Method for Using dbloc2 and dbpick” in this Manual.

(Step 3b) After acquiring a good location save it and open alarm database. You can access this

database at the bottom of the dbloc2 window. Under “Database” right click for a pull-down

menu and select alarm database. A dbe window will open. Choose origin table. Alternatively,

you can open alarm database from “Response” window by clicking on “view database” but-

ton. If the event is ML 5 or larger, coordinate location, depth and magnitude with NEIC (See

Section 7.2 of this Manual).

(Step 3c) When confident with your solution, highlight any field in the origin table that corre-

sponds with the appropriate solution. Then click “Edit” and choose “Respond” or “Update”
from the pull-down menu.
Last update 02/26/2008 by N.Ruppert.
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IV. CHECK FOR FELT REPORTS:

(Step 4a) Check your own or dutylap (passw               ) e-mail for messages from Shake Account
with felt reports. Check DYFI page for Alaska for felt reports:

http://pasadena.wr.usgs.gov/shake/ak/.
(Step 4b) The felt_report_tool should now be open. Call a reasonable number of contacts to learn

all you can about their experience. Edit the felt report to accurately describe the event. List

where the event was felt, damage, etc. It this is an aftershock, add the description: “This is an
aftershock of the magnitude XX event that occurred on DA/MO/YEAR at 00:00 ADT”. When

satisfied click “Submit felt-report synopsis”. You are now committed to the event!

V.A. CREATE RELEASE IN THE LAB:

(Step 5a) A map of the earthquake will show up on your monitor, then quickly close. Be patient

and wait for Framemaker to start. Do not click anything or type any keys!

(Step 5b) When Framemaker does open, press “Control-1”. This activates a macro that is import-

ing relevant event data. Wait for it to finish.

(Step 5c) Press “Control-3”. This saves the document in your releases directory and sends it to

the printer (lexbw). Several file conversions will take place, so be patient for a few moments.

Framemaker will quit and aeic_release_distributor will start.

V.B. CREATE RELEASE THROUGH DUTYLAP:

(Step 5a) A map of the earthquake will show up on your monitor, then quickly close. Be patient

and wait for Framemaker to start. Do not click anything or type any keys! It may take up to 5

minutes depending on your internet connection.

(Step 5b) When Framemaker does open, press “Control-1”. This activates a macro that is import-

ing relevant event data. Wait for it to finish. You won’t be able to see the imported map.

(Step 5c) Do not use “Control-3”. In this case saving and printing has to be done manually.

Do the following sequence of commands in the FrameMaker document window:

File -> Print -> Destination-Printer Lexbw -> Print
File -> Print -> Destination-PDF File -> Change file name -> Print
File name has to be changed from myrelease.pdf to YYYYMMDDHHMMSS_.pdf. Do not

change directory. For example,

/home/dutylap/releases/20070101223344/myrelease.pdf
has to be changed to

/home/dutylap/releases/20070101223344/20070101223344_.pdf
It’s important to have the correct file name. Otherwise the next program will never open. If

everything goes well, Framemaker will quit and aeic_release_distributor will start. Several

file conversions will take place, so be patient for a few moments. If nothing happens after over

5 minutes of waiting, see the “Troubleshooting” section (page 39).
Last update 02/26/2008 by N.Ruppert.
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VI. RELEASE DISTRIBUTION:

Note: the following order may be changed.

(Step 6a) Click “Update Release Database”

(Step 6b) Click “Email information release to aeic_release”

(Step 6c) Click “Fax information release”

(Step 6d) Click “Update web release”

(Step 6e) Click “Send release to cell phones”

(Step 6f) Click “Update finger quake list”

(Step 6g) Click “Update lab voice mail” Refer to Section 7.3 of this Manual for instructions.

(Step 6h) Click “Notify people on the call down list”. Answer the two questions that come up.

You will automatically be instructed what numbers to call if necessary.

(Step 6i) Select the red “Quit” button.

Pick up the printout when finished. On the lab bench is a two hole press. Use it on the top of the

page, then place it on the clipboard hanging on the wall by the door to the secure computer

room.

THAT’S IT!!

Don’t forget to close all programs and windows after you’re done.
Last update 02/26/2008 by N.Ruppert.
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7.2. Coordinating Magnitudes with NEIC.

7.2.1. Finding the magnitude.
For events with reviewed magnitudes 5 and higher coordinate magnitudes with NEIC.

Reviewed locations come through e-mail and are available on NEIC website:

http://earthquake.usgs.gov/eqcenter/recenteqsus/Maps/special/Alaska.php

(1) Preferred source: NEIC website. Find your earthquake either on the map or in the event list

and click on it. It will take you to a summary page for this event. The “Source” field should be

USGS NEIC and it has to be a reviewed earthquake. Wait for it to be reviewed. Once it has

been reviewed, look at the “Magnitude” field for the preferred magnitude value and at the

“Parameters” field for type of magnitude. This is the magnitude that needs to be reported in

your release.

(2) Second choice: E-mail from NEIC with the reviewed location. See example below. There are

two places in which the magnitude is given. One is in the upper right part of the e-mail mes-

sage body that gives the value and source of the magnitude, but not its type. Farther down in

the message there is a line with various magnitudes, including mb. If the magnitude value on

the top matches with mb below, then this is your magnitude for the release. If magnitude at the

top does not match with mb, we assume its Mw. The former is true for most light and moderate

earthquakes. The latter is more likely to be the case for strong and major earthquakes.

###############################################################################

Date: Wed, 9 Jan 2008 14:49:54 GMT

From: bellini@nsn8.cr.usgs.gov

To: nsn_list@kiska.giseis.alaska.edu

Subject: REVIEWED LOCATION FROM USGS/NEIC

      9 JAN 2008  (  9)                             LZAS

     ot  = 14:40:01.21   +/-   0.23              QUEEN CHARLOTTE ISLANDS REGION

     lat =      51.701   +/-    3.9

     lon =    -131.096   +/-    3.9              MAGNITUDE 6.2 (GS)

     dep =        10.0  (geophysicist)

     210 km (130 miles) WSW of Bella Bella, British Columbia, Canada

     265 km (165 miles) SSE of Masset, British Columbia, Canada

     630 km (390 miles) WNW of Vancouver, British Columbia, Canada

     665 km (410 miles) NW of VICTORIA, British Columbia, Canada

     nph =   91 of 103    se = 1.03    FE=022                            A

     error ellipse = ( 45.7,  0.0,  6.8;135.7,  0.0,  2.4;  0.0,  0.0,  0.0)

 mb = 5.7 ( 63)  ML = 0.0 (  0)  mblg = 0.0 (  0)  md = 0.0 (  0)  MS = 0.0 (  0)

#####################################################################

(3) Last resort: Call NEIC hotline for regional networks 303-273-8439.
Last update 02/26/2008 by N.Ruppert.
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7.2.2. Entering NEIC magnitudes into the database and release files.

(1) Entering mb. This has to be done in the origin table of your alarm database. Do the following:

- Options -> Allow edits
- View -> Arrange. A “Display order” window will paper.

- Check mb parameter and click “OK” button. This parameter will be added as the last

column in your origin table.

- Click on your added mb field and type in your mb value.

- Proceed with release through Edit->Respond option.

mb value will be chosen by the response software as your preferred magnitude for the release.

No need to do anything else in terms of the magnitude.

(2) Entering Mw. Enter mb value in the origin table if it is available for this event (see above). The

origin row has to have ml and/or mb for the response software to be launched. There is no

field for Mw in the origin table, so it has to be entered manually in all release files:

- Framemaker document: Change magnitude value, type (Mw) and source (NEIC) as

needed both in the text body and in the earthquake parameter block. See if the earth-

quake strength needs to be changed too. See terminology in Session 10.1 of this Man-

ual.

- E-mail message: Change magnitude value, type (Mw) and source (NEIC) as needed in

the subject line, text and the earthquake parameter block. See if the earthquake

strength needs to be changed too.

- Voice mail message: Substitute different magnitude and earthquake strength as needed.
Last update 02/26/2008 by N.Ruppert.
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7.3. Update the Lab Voice-mail Message.

1) Call up the voice-mail system:

Dial 1800 on campus or 474-1800 from off campus

2)Log in:

for the box number,

Enter 4300 #

for the password,

Enter 4300 #

3) Access the greetings:

Press 82

4) Access the external greeting

Press 1

5) Delete the old greeting

Press 76

6) Record new greeting

Press 5
read the new greeting
Press # to stop

7) Review the greeting ( ! )

Press 2

8) Exit the mailbox

Press 4
Last update 02/26/2008 by N.Ruppert.
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8. AEIC Response Software Documentation.

8.1. Introduction.

The AEIC response software allows construction of all the information-release products for an

alarm-release event at the Alaska Earthquake Information Center.

8.2. Synopsis.

•Create or steal a location and magnitude for the event. Put it in a CSS database.

•Launch dbe on the database and highlight a field in the correct row of the origin table.

•Choose Edit->Respond from the dbe menubar for a full release.

•Choose Edit->Update from the dbe menubar for a partial release.

•Report problems in writing.

8.3. The Full Release Procedure.

The first step is to locate the earthquake. This may be done with Xpick, with dbloc2, with another

location program, or by stealing from appropriate sources such as the National Earthquake Infor-

mation Center. Once the earthquake is located, the hypocentral coordinates must be put in a Data-

scope database. Usually this means you have to have a row in an origin table of a CSS database,

although the related schemas of rt1.0, iceworm1.2, and iceworm1.3 should work as well. If you

have located the earthquake with dbloc2, the hypocenter will already be in a database. Otherwise

you may have to use a conversion program, for example pick2db for pickfiles, or at worst enter the

hypocenter by hand with the spreadsheet program dbe.

Once you have a database containing the hypocenter, you need to launch the main response script.

This is called aeic_respond. There are several ways to launch aeic_respond such that it knows

both the database you’re working from as well as which hypocenter in the database you want to

release. If you are running dbe and your account is properly set up, you may pull up the origin

table, highlight a field in the row of interest, and choose Edit->Respond from the menu bar. You

can also pull up the event table and do the same, in which case the preferred origin for that event

will be chosen. If you’re running from the command line, you may type

aeic_respond dbname

If there is only one event or one hypocenter in the database, aeic_respond will automatically

know that you want to respond to that one. If there are multiple events or origins in the database,

you should specify which one you want with -o orid or -e evid, where the orid and/or evid num-

bers for the hypocenter may be obtained from dbe.
Last update 02/26/2008 by N.Ruppert.
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Once a hypocentral location is chosen, the response software will present the user with the

felt_report_tool. On the screen, it looks like this:.

At the top is a summary of the earthquake’s vital statistics, for convenience in calling people. The

next window is a small text editor for the felt-report sentence or sentences. The stock report is that

“no reports of this event having been felt and/or causing damage have been received at this time.”

This text should be updated based on the calls made. The next lower section of the

felt_report_tool is a list of the nearest contact phone numbers for the earthquake, along with

direction and distance information. This list is generated from a database, which may have more

than one contact listed for each city. The responding seismologists should use their discretion

about how many people to call. Below the contact list is a set of buttons. The first allows the list to

be sent to the standard printer. The second allows a spreadsheet to be brought up of the full data-

base of contact information, in case the seismologist wants to get a phone number that wasn’t

included on the quick-reference list. The spreadsheet is actually accomplished with the dbe pro-
Last update 02/26/2008 by N.Ruppert.
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gram, for those familiar with it. The main window of dbe, which will appear if you hit the “Show

contact database” button, looks like this:

Hitting the “places” button brings up a table of places in the database
Last update 02/26/2008 by N.Ruppert.
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Similarly, hitting the “phone” button will bring up a table of phone-number contacts:

Standard database subsetting and joining operations, explained in the documentation for dbe, may

be used to generate appropriate subsets of the information:
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The next button in the felt_report_tool allows users to report problems with phone numbers to the

person responsible for maintaining the database. This is critical if we are to have a useful database

of contact information. Hitting this button brings up a problem-submission window with a one-

line text-entry field:

Finally, the “Submit felt report synopsis” button on the felt_report_tool commits the seismologist

to the edited felt report. When this button is hit, the felt_report_tool will disappear, allowing the

response process to continue to the next step. The last button on the felt_report_tool allows the

seismologist to abandon the response process. The button appears on the felt_report_tool rather

than elsewhere since this tool is the first in the sequence of response scripts.

The next steps of the response process are all automatic. The scripts will generate a map for inclu-

sion in the fax release. This map will pop up on the users window but does not need to be modi-

fied or bothered:
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After generating this map, and converting it quietly to other formats, the response scripts will

launch framemaker. When Framemaker comes up, it will have a pre-loaded template for the infor-

mation release:

Now, with the cursor in the large blank box as shown, Hit “Cntl-1” to trigger the construction of

the specific release information for this earthquake. That’s “Control-one”. The macro is finished

working when the map is in the correct place.
Last update 02/26/2008 by N.Ruppert.



20
It should look approximately like this:

Review the document. Edit if necessary. Then hit “Cntl-3” to commit to the completed release.

This will print out the release [unless you’re running in training mode] to the printer specified in

the aeic_release.pf parameter file, currently the default printer is “lexbw” located in the dark

room. Then it will create the PDF file for the web release. Also, Framemaker will exit at this time.

After the Framemaker editing window disappears, there will be a pause for some quiet file-con-

version operations. The Framemaker master window

will disappear after all the file conversions are done. If the script has difficulty killing Frame-

maker, it will print a message asking you to exit Framemaker. Also, if anything goes wrong with

the PDF file conversion, Framemaker will not exit and the aeic_respond script will not proceed.
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This is because the aeic_respond script looks for the new PDF file to decide that Framemaker’s

work is done.

The final stage of the response process is to distribute information to appropriate locations. A

helper application called aeic_release_distributor is responsible for all distribution tasks:

Each button triggers one of the distribution steps. The buttons are the broad colored bars. The

checkboxes at left are intended for notetaking by the seismologist. If a button is pressed, the cor-

responding checkbox will turn red to indicate that the task has been completed. Also, the button

will be deactivated. To intentionally skip a task, one can check the checkbox red and the task will

be marked as completed without being done. If you need to repeat one of the tasks and the button

has been disabled, un-clicking the red check box will reactivate the button.

Some functions run silently in the background and do not require additional input from analyst

(“Update web release”, “Send release to cell phones”, “Update finger quake list”, “Update
Release Database”, “Fax Information Release”).

The following is a description of the functions that are interactive and may require additional

input from analyst.
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The button “Notify people on calldown list” brings up the calldown_notification_tool. The first

screen of this tool is a short survey, which looks like this:

Fill out the two-question survey, then hit “Commit.” If no entries in the database meet the thresh-

old for notification, the following screen will appear:
Last update 02/26/2008 by N.Ruppert.



23
On the other hand, if there are people to call, they will appear in a list. These numbers are also

updated and listed on pages 41 and 42 of the beeper duty manual.

The buttons here are similar to those in the felt_report_tool, though the calldown database looks a

bit different:
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The “contact” table shows the names of people who may want to be contacted:

The “threshold” table tells when to contact these people for each different region of interest:
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Finally, each region is defined by the vertices of a polygon. The “regions” table gives the ordered

set of vertices defining each region:
Last update 02/26/2008 by N.Ruppert.
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The “Email information release” button of the aeic_release_distributor brings up an editor with

which you can review, and if necessary modify the email information release. The window looks

like this:
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The “Update Lab voice mail message” button of the aeic_release_distributor brings up a win-

dow with instructions on how to do the update. The window looks like this:

“Print” button would make a print out of the message, but no the instructions.
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The “Mail feedback” window brings up a text-editor with which to send feedback about the

entire response process:

If you quit the aeic_release_distributor without completing some of the tasks, or with some of the

tasks intentionally skipped, you will get a warning message:
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8.4. The Partial Release (UPDATE) Procedure.

This procedure is similar to a full release, however there are fewer steps. Follow the same proce-

dure for a full release with respect to locating the earthquake. Once you have a database of the

event, you need to launch the partial release script. This is called aeic_partial_release. If you are

running dbe and your account is properly set up, you may pull up the origin table, highlight a field

in the row of interest, and choose Edit->Update from the menu bar. You can also pull up the

event table and do the same, in which case the preferred origin for that event will be chosen.

The following image will pop-up.

Click each button. Then Quit.
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8.5. AEIC Release Procedure for Training Purposes.

For instructional and testing purposes, there is a -n “nofangs” option to the aeic_respond script:

aeic_respond -n dbname

With this option printouts will not be made, mail will not be sent, web releases will not be posted

etc.

If you are running the script in “nofangs” mode, the aeic_release_distributor will look like this:
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8.6. First-Order Corrections.

We are aiming to make glitch-free software. However, in the interim, things may go wrong until

we identify and correct possible problems. Reminder: Please report all problems in writing.

All work by aeic_respond is done in a single directory specified by the parameter file. Currently

this is a subdirectory called ~/releases in the users home directory. A subdirectory named accord-

ing to the time of the event contains all of the temporary files and output files if something needs

to be edited by hand. An example listing of the finished directory is shown here:

nordic% ls /home/kent/releases/990209143344/

990209143344_.gif          dbmapevents.epsi        myrelease.fm.lck

990209143344_.pdf         dbmapevents.ps           myrelease_db.arrival

aeic_release.email             eva_log.text                 myrelease_db.assoc

aeic_release.makertext      fmMacros                    myrelease_db.origin

aeic_release.pf                  myrelease.backup.fm

db_release.epsi                 myrelease.fm

 nordic%

Hopefully most of these will be self explanatory. They may be used to complete a release manu-

ally if something goes wrong with the automatic procedures. If something goes wrong halfway

through the response procedures, the user may pick up from where the scripts left off with the par-

tial results in this directory.

The major component programs of the release process are as follows:

aeic_respond: This is the driver script for the response process. This is the normal entry point into

the response process. It is launched from the command line as explained above, or from dbe with

the Edit->Respond Menubar option.

felt_report_tool: This script is launched with one argument, the name of the subset database con-

taining only the single origin of interest. Under normal conditions this subset database will be

placed in the working directory by the aeic_respond script.

dbmaprelease: This program is launched with the database name, the orid for the hypocenter to

be mapped, and the range of the map. The map needs to be converted to epsi, preferably using the

alchemy software.

maker: This is the launch script for framemaker. There is a template for AEIC information

releases, into which one imports the response text and the map. Under normal conditions the

working directory contains two versions of the response text for the earthquake, one formatted for

email distribution and one specifically formatted for the idiosyncrasies of importing text into

framemaker (tabs adjusted correctly, etc.).

aeic_release_distributor: This must be run with no command-line arguments from the working

directory.
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calldown_notification_tool: This must be run with one argument, which is the database name of

the subset database containing only one origin row, corresponding to the hypocenter of interest.

Under normal conditions this subset database will be placed in the working directory by the

aeic_respond script.

All of these component programs rely on the contents of the aeic_release.pf parameter file. View-

ing this file may provide clues to hunt down particular pieces of the puzzle if necessary. To check

whether the aeic_release parameter file is visible from your account as it is set up, type

pfecho aeic_release

This should print out the apparent contents of this parameter file.

During normal operation, the aeic_respond script generates or triggers the generation of some

output to the screen from which it was launched (or from which its parent process, such as dbe,

was launched). A snapshot of one instance of this output, for a run which went smoothly, is shown

below:

nordic% dbe alarm

aeic_respond:   Launching felt_report_tool...

aeic_respond:   Launching thumbnail-map generator...

Image Alchemy PS (v1.11) - Copyright (c) 1990-98, Handmade Software, Inc.
Reading EPS / PostScript file dbmapevents.ps
Writing EPS / PostScript file dbmapevents.epsi (output type 3000)
Interpreting PostScript file -
Saving image........................................

aeic_respond:   Launching Framemaker...

starting maker ...
maker: Using /usr/local/frame5.5/fminit
maker: Starting FrameMaker 5.5. Copyright (c) 1986-1997 Adobe Systems Incorporated.
Before using FrameMaker for the first time, read the online manual “Customizing FrameMaker
Products” for information on  configuring FrameMaker products for use with various window
managers.
maker: Finished loading
fmprintdr.ps: Using /usr/local/frame5.5/fminit
request id is ec-153 (1 file(s))
fmprintdr.ps: Using /usr/local/frame5.5/fminit

WARNING: This version of the Acrobat Distiller may not be fully compatible with previous versions
 of Acrobat Exchange and Acrobat Reader due to new functionality based on recent PDF language
 additions.  To ensure compatibility with previous versions of Acrobat Exchange and Acrobat Reader,
 the DEFAULT for compatibility can be set inside your personal preference file.  Setting this
compatibility switch, however, will result in the disabling of new features of the Acrobat Distiller.
The compatibility switch may easily be overridden at run-time through the specification of
compatlevel and in no way represents an actual permanent loss of features for Acrobat Distiller.
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NOTE: Running the Acrobat Distiller with the -noprefs option will effectively disable the
preference chosen below.

   Enter Acrobat Distiller personal preferences file modification [1, 2, 3]
      [1] use 3.0 new features
      [2] use 2.1 compatibility
      [3] leave compatibility undefined
Image Alchemy PS (v1.11) - Copyright (c) 1990-98, Handmade Software, Inc.
Reading Adobe PDF file /home/kent/work/response/990218182358/  990218182358_.pdf
Writing GIF file /home/kent/work/response/990218182358/990218182358_.gif
Interpreting PDF file \
Saving image........................................                (00:01:55)

aeic_respond:   Launching aeic_release_distributor...

aeic_respond: Successfully finished earthquake response.
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8.7. Customizing and Tuning the AEIC Response Software.

The AEIC response software is configured by an Antelope [BRTT, Inc.] parameter file. Most of

the contents of this parameter file will not need to be changed by standard users. An example of

this parameter file is shown here:

# aeic_release parameter file
#

# K. Lindquist

# Geophysical Institute

# University of Alaska, Fairbanks

# 1999

#######################################################################
# Where to send the output
email_release_recipient aeic_release

fax_release_recipient &Literal{

   907XXXXXXX@emailfaxservice.com, 703XXXXXXX@emailfaxservice.com}

web_directory            /usr/local/frame2html/results

release_database        /Seis/catalogs/releases/initial_releases

cellphone_mail_recipients       &Arr{

    907XXXXXXX@msg.acsalaska.com

    907XXXXXXX@mobile.celloneusa.com

}

printer lexbw

#######################################################################
# Where to get necessary information and templates
cellphone_reference_cities      /Seis/databases/places/cellphone_cities

common_place_database   /Seis/databases/places/wellknown_alaskan_cities

place_database  /Seis/databases/places/cities

maker_template  /usr/local/aeic/4.7/data/response/aeic_response_template.fm

region_phrases_database /Seis/databases/regions/alaska_region_phrases

contact_database        /Seis/databases/notify/contactss

number_of_contacts 40 # How many contacts to show for felt report investigation

#######################################################################
# What the output should look like
num_nearest 8           # Number of nearest cities shown

map_range 4 # Range of map in degrees

stock_felt_report &Literal{

No reports of this event having been felt or causing damage

have been received at this time.

}

voicemail_file  aeic_voicemail_text

voicemail_instructions  &Literal{

Dial 1800               on campus for voice-mail access

Enter 7320#     for the box number

Enter 7320#     or 5681# for the password

Press 82                to access the greetings

Press 1         to access the external greeting
Last update 02/26/2008 by N.Ruppert.
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Press 76                to delete the old greeting

                Record the new greeting:

Press 5

read the new greeting

Press #         to stop

Press 2         to review the greeting (!)

Press 4         to exit the mailbox

}

#######################################################################
# Where and how to get the job done, and with what software
base_release_dir HOME/releases

# Working files. These templates refer to the origin time
email_file                aeic_release.email

email_update            aeic_update.email

makertextfile aeic_release.makertext

fmrelease_file myrelease.fm

fmpdf_file %y%m%d%H%M%S_.pdf

gif_release_file %y%m%d%H%M%S_.gif

map_epsi_file        db_release.epsi

subset_database  myrelease_db

Helpers &Arr{

    Framemaker  /usr/local/frame6.0/bin/maker

    aeic_partial_release        /usr/local/aeic/4.7/bin/aeic_partial_release

    aeic_release_distributor    /usr/local/aeic/4.7/bin/aeic_release_distributor

    alchemy     /usr/local/bin/alchemy

    calldown_notification       /usr/local/aeic/4.7/bin/calldown_notification_tool

    cellphone_notifier  /usr/local/aeic/4.7/bin/aeic_cellphone_release

    dbmaprelease        /usr/local/aeic/4.7/bin/dbmaprelease

    felt_report_tool    /usr/local/aeic/4.7/bin/felt_report_tool

    tkshow_message      /usr/local/aeic/4.7/bin/tkshow_message

    update_finger       /usr/local/aeic/4.7/bin/update_finger

    rtmail                          /opt/antelope/4.7/bin/rtmail

}

#######################################################################
# Who to harass with problems
maintainer natasha@giseis.alaska.edu

pf_revision_time        1117047267

#######################################################################

The two parameters that general users might be interested in modifying would be the

base_release_dir, in order to relocate the directory of working files somewhere else in their home

directory, or the printer. These modifications should be made by putting a subset parameter file

called aeic_release.pf, containing just these modifications, in the ~/data/pf directory of the users

home directory. Again, this presumes the environment variable PFPATH is correctly set, i.e. by

using the System Administrator’s standard setup files.
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8.8. Common Questions.

You may dry-run the entire procedure without consequence, until you get to the final

aeic_release_distributor button window. Up to this point, at worst you will waste a sheet of paper

making a printout of a non-release.

If the aeic_respond script does not exit, even though you appear to completed all the tasks, make

sure you do not still have any of the child processes running, such as a dbe launched from within

the response software.

The aeic_respond script makes a working directory, usually in a subdirectory called “releases” in

your home directory. All work for an event is done in a subdirectory of this releases directory.

The name of the subdirectory is a timestamp based on the origin time of the earthquake

(YEARMODAHOMISE). If the directory already exists, for example if you are rerunning

aeic_respond on the same earthquake or on a different earthquake that occurred in the same

minute, you must remove or rename the other directory or aeic_respond will complain and exit.

After framemaker exits, the pdf file is converted to a gif file for the web. In order to make a rea-

sonable quality image, this procedure takes about a minute and a half. There is a small clock in the

text output of the command which should keep you occupied and entertained.

8.9. Troubleshooting a Problem Release.

- If you subset a database and deleted tmp directory but dbloc2 would not start:

Open an Xterm window and type

dbloc2 -r alarm
It will either launch dbloc2 or give you a command to run to unregister dbloc2 buttons. Run

the unregister command exactly as it is given to you and then start dbloc2 again with the

alarm database.

- If you have located an event and saved it in alarm database, you can start response by opening

the alarm database from the command line by typing dbe alarm and opening origin table. You

do not have to subset the database again and relocate this event.

- If you previously aborted a response or update and want to return to the same event, you first

have to remove directory created for this event in the releases directory and only then restart

release or update:

cd /home/YOU/releases
rrm -r YYYYMMDDHHMMSS

- If aeic_release_distributor does not launch after you went through all steps in FrameMaker, you

can open it from release directory for this particular event:

cd /home/YOU/releases/YYYYMMDDHHMMSS
aeic_release_distributor
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8.10. Known Problems.

1) If you do not have enough disk space in your home directory for the temporary files, the entire

procedure will die unpleasantly.

2) Currently, the driver script does not check whether it will be possible to get a license for Frame-

maker. The results of failure to get a license are unpredictable.

3) The finger quake implementation currently depends on /Seis/pickfiles. This will need to be

completely overhauled in order for non-pickfile solutions to appear in the finger quake list.

4) Sometimes the “commit” macro, the “Cntl-3” macro in Framemaker, moves a little too fast for

the system to keep up. The PDF file starts to get printed before the framemaker script sending

the file to the printer is finished. The result is the following dialog box from Framemaker:

At this point hit “OK”. This idiosyncrasy appears harmless.

5) There are a couple problems that don’t really apply to these scripts directly, but the user should

be aware of them. If the descriptor file for the database points to some files on a system which

is down, you may get an “NFS server earlybird [megathrust, etc.] not responding” hang. For

example, if the descriptor file points to the site database /iwrun/op/params/Stations/worm, and

if that site database is on Earlybird, and Earlybird is down, dbe will hang. The solution here

would be to point to the backup site database instead, and restart dbe. Similarly, if

aeic_respond does not start up because of an NFS server problem, your computer may need to

be rebooted by the system administrator.

6) Sometimes aeic_respond brings up two copies of aeic_release_distributor. Just use one of

them.
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8.11. Limited Warranty.

We are committed to building response software that does not break, die, fail, squeal, whine, or

spit stomach acid at its users. This is a challenging task, but worth the effort to avoid unpleasant

experiences at 3:00 am. In order to achieve the goal of seamless performance, we need coopera-

tion from the users. The following are the necessary terms of this warranty:

1) The software was written under certain assumptions. The user must adhere to these assump-

tions:

•First, the approved system-setup shell for your account is tcsh.

•Second, the user must run the System-administrator’s path, login, and environment setup

files.

2) Report all errors, inconveniences, and problems in writing.
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9. AEIC Phone Lists.

Table 1: AEIC Numbers to Know!

Name Phone

Beeper Duty Cell Phone 978-8572 (CellOne)

Beeper Duty Pager 496-3588 (Personal Page)

Seismology Lab - General 474-7320

Seismology Lab - AVO 474-5681

State Seismologist Cell Phone 460-7215

Table 2: Affiliated Organizations

Name Phone

West Coast/Alaska Tsunami Warning Center 907-745-4212

907-694-2698 (do not give out)

NEIC Main Number 303-273-8500 (hard to get through)

NEIC Recorded Message 303-273-8515

NEIC Hotline 303-273-8439 (for regional networks)

Table 3: Press

Name Phone

Associated Press 907-272-7549

206-682-1812 (after hours)

Fairbanks Daily News Miner 456-6661
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Table 4: Beeper Duty Personnel

Name Office Home Email

Burris, Lea x 7460 374-5920 leab@giseis.alaska.edu

LaFevers, Martin x 5627 456-1370 martin@giseis.alaska.edu

Kozyreva, Natasha x  6873 699-6011 kozyreva@giseis.alaska.edu

Roush, Jamie x 5161 456-3092 jamie@giseis.alaska.edu

Ruppert, Natasha x 7472 451-7257 natasha@giseis.alaska.edu

Sandru, John x 1151 457-3735 sandru@giseis.alaska.edu

Thompson, Glenn x 7472 455-6918 glenn@giseis.alaska.edu

Table 5: Non-beeper Duty Personnel

Name Office Home Email

Estes, Steve x 7425 479-5819 estes@gi.alaska.edu

Freymueller, Jeff x 7286 479-3550 jeff@giseis.alaska.edu

Hansen, Roger x 5533 451-0780 roger@giseis.alaska.edu

Robinson, Mitch x 7440 458-9065 mitch@giseis.alaska.edu

Suleimani, Elena x 7997 458-9517 elena@giseis.alaska.edu

Table 6: AVO Fairbanks Numbers to Know

Seismology Lab:  474-7320 CS and AVO cell phones: 322-4084 and 322-4085

Seismology Drums:  474-5681 AVO duty seismologist   590 8248

Emergency Phone in Lab:  474-5682

Table 7: AVO Fairbanks Personnel

Name Office Home E-mail

Dixon, Jim x 6014 479-4306 dixon@giseis.alaska.edu

McNutt, Steve x 7131 474-9600 steve@giseis.alaska.edu

Nye, Chris x 7430 455-6695 cnye@giseis.alaska.edu

Stihler, Scott x 5450 474-2138 scott@giseis.alaska.edu

Tytgat, Guy x 7274 460-0016 guy@giseis.alaska.edu
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10.1. Earthquake Strength Terminology.

10.2. Sources of Data.

Continuous Waveform Data:

/iwrun/op/db/archive/archive - operational system

/iwrun/bak/db/archive/archive - backup system

Earthquake database:

/iwrun/sum/db/dbsum/dbsum

Magnitude Range Strength

3.0 - 3.9 minor

4.0 - 4.9 light

5.0 - 5.9 moderate

6.0 - 6.9 strong

7.0 - 7.9 major

8.0 + great
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10.3. Modified Mercalli Intensity Scale.
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10.4. Parameter File aeic_release.pf.

/opt/local/aeic/4.6/data/pf/aeic_release.pf

# aeic_release parameter file
#

# K. Lindquist

# Geophysical Institute

# University of Alaska, Fairbanks

# 1999

#######################################################################
# Where to send the output
email_release_recipient aeic_release

fax_release_recipient &Literal{

   907XXXXXXX@emailfaxservice.com, 703XXXXXXX@emailfaxservice.com}

web_directory            /usr/local/frame2html/results

release_database        /Seis/catalogs/releases/initial_releases

cellphone_mail_recipients       &Arr{

    907XXXXXXX@msg.acsalaska.com

    907XXXXXXX@mobile.celloneusa.com

}

printer lexbw

#######################################################################
# Where to get necessary information and templates
cellphone_reference_cities      /Seis/databases/places/cellphone_cities

common_place_database   /Seis/databases/places/wellknown_alaskan_cities

place_database  /Seis/databases/places/cities

maker_template  /usr/local/aeic/4.7/data/response/aeic_response_template.fm

region_phrases_database /Seis/databases/regions/alaska_region_phrases

contact_database        /Seis/databases/notify/contactss

number_of_contacts 40 # How many contacts to show for felt report investigation

#######################################################################
# What the output should look like
num_nearest 8           # Number of nearest cities shown

map_range 4 # Range of map in degrees

stock_felt_report &Literal{

No reports of this event having been felt or causing damage

have been received at this time.

}

voicemail_file  aeic_voicemail_text

voicemail_instructions  &Literal{

Dial 1800               on campus for voice-mail access

Enter 7320#     for the box number

Enter 7320#     or 5681# for the password

Press 82                to access the greetings

Press 1         to access the external greeting

Press 76                to delete the old greeting

                Record the new greeting:

Press 5

read the new greeting
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Press #         to stop

Press 2         to review the greeting (!)

Press 4         to exit the mailbox

}

#######################################################################
# Where and how to get the job done, and with what software
base_release_dir HOME/releases

# Working files. These templates refer to the origin time
email_file                aeic_release.email

email_update            aeic_update.email

makertextfile aeic_release.makertext

fmrelease_file myrelease.fm

fmpdf_file %y%m%d%H%M%S_.pdf

gif_release_file %y%m%d%H%M%S_.gif

map_epsi_file        db_release.epsi

subset_database  myrelease_db

Helpers &Arr{

    Framemaker  /usr/local/frame6.0/bin/maker

    aeic_partial_release        /usr/local/aeic/4.7/bin/aeic_partial_release

    aeic_release_distributor    /usr/local/aeic/4.7/bin/aeic_release_distributor

    alchemy     /usr/local/bin/alchemy

    calldown_notification       /usr/local/aeic/4.7/bin/calldown_notification_tool

    cellphone_notifier  /usr/local/aeic/4.7/bin/aeic_cellphone_release

    dbmaprelease        /usr/local/aeic/4.7/bin/dbmaprelease

    felt_report_tool    /usr/local/aeic/4.7/bin/felt_report_tool

    tkshow_message      /usr/local/aeic/4.7/bin/tkshow_message

    update_finger       /usr/local/aeic/4.7/bin/update_finger

    rtmail                          /opt/antelope/4.7/bin/rtmail

}

#######################################################################
# Who to harass with problems
maintainer natasha@giseis.alaska.edu

pf_revision_time        1117047267

#######################################################################
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10.5. Parameter file orb_quake_alarm.pf.

/iwrun/sum/sun/pf/orb_quake_alarm.pf

#####################################################################

message_expressions &Arr{

        local_time      epoch2str(time,”%a %b %o at %l:%M %p %Z”,””)

        gmt_time        epoch2str(time,”%L/%d/%Y %H:%M:%S.%s GMT”)

        subj_time       epoch2str(time,”%D %H:%M”)

beeper_mag ml != NULL ? “Ml “ . ml : ( mb != NULL ? “Mb “ . mb : ( ms != NULL ? “MS “ . ms : “No mag”

) )

        email_mag       ml != NULL ? ml . “ Ml” : ( “NO MAG” )

        grname          grname(lat,lon)

near_fairbanksdistance(lat,lon,64.836,-147.7098) < 0.5 ? 1 : 0

near_anchoragedistance(lat,lon,61.2175,-149.9002) < 0.5 ? 1 : 0

near_juneau     distance(lat,lon,58.3012,-134.4185) < 0.5 ? 1 : 0

}

alarms &Arr{

    hypocenter &Arr{

# Trigger conditions for aeic beeper duty earthquake alarms

        aeic_beeper_cell    &Arr{

                trigger_condition       &Literal{

                        ( ndef >= 15 && ml >= 3.45 && %{near_anchorage} && review == NULL ) ||

                        ( ndef >= 15 && ml >= 3.45 && %{near_fairbanks} && review == NULL ) ||

                        ( ndef >= 15 && ml >= 3.45 && %{near_juneau} && review == NULL ) ||

                        ( ndef >= 15 && ml >= 3.75 && %{in(South-central Alaska)} && review == NULL ) ||

                        ( ndef >= 15 && ml >= 3.95 && %{in(Mainland Alaska)} && review == NULL ) ||

                        ( ndef >= 15 && ml >= 3.95 && %{in(South-east Alaska)} && review == NULL ) ||

                        ( ndef >= 15 && ml >= 4.95 && %{in(Eastern Aleutians)} && review == NULL ) ||

                        ( ndef >= 15 && ml >= 4.95 && %{in(Central Aleutians)} && review == NULL ) ||

                        ( ndef >= 15 && ml >= 4.95 && %{in(Western Aleutians)} && review == NULL )

                }

                subject         Alarm %{alarmid}, Evid %{evid}

                body            &Literal{

      %{beeper_mag}, %{ndef} ph., %{depth} km, %{local_time}, %{nearest(1)}

                }

                wait_ack        1

                ack_subject Acknowledgment for alarmid %{alarmid}

                ack_body    Cancelled by %{ackauth} at %{acktime}

                recipients      &Arr{

                        9076996011@msg.acsalaska.com           0 # N.Kozyreva

                        9074601875@msg.acsalaska.com           0 # N.Ruppert

#                        9074604488@msg.acsalaska.com           0

                        4963588@epage.personal-page.com        180 # beeper pager

                        9079788572@mobile.celloneusa.com       0 # beeper cell

                        9074607215@mobile.celloneusa.com       600 # R.Hansen

                }

        }
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# Trigger conditions for beeper duty e-mail notifications

       aeic_beeper_email    &Arr{

                trigger_condition &Literal{

                        ( ndef >= 4 && ml >= 3.45 && %{near_anchorage} && review == NULL ) ||

                        ( ndef >= 4 && ml >= 3.45 && %{near_fairbanks} && review == NULL ) ||

                        ( ndef >= 4 && ml >= 3.45 && %{near_juneau} && review == NULL ) ||

                        ( ndef >= 4 && ml >= 3.45 && %{in(South-central Alaska)} && review == NULL ) ||

                        ( ndef >= 4 && ml >= 3.45 && %{in(Mainland Alaska)} && review == NULL ) ||

                        ( ndef >= 4 && ml >= 3.45 && %{in(South-east Alaska)} && review == NULL ) ||

                        ( ndef >= 4 && ml >= 3.95 && %{in(Eastern Aleutians)} && review == NULL ) ||

                        ( ndef >= 4 && ml >= 3.95 && %{in(Central Aleutians)} && review == NULL ) ||

                        ( ndef >= 4 && ml >= 3.95 && %{in(Western Aleutians)} && review == NULL )

                }

                wait_ack        0

                ack_subject

                ack_body

                subject         AEIC AUTOMATIC EQ: MAG %{ml} %{subj_time} UT, %{grname}

                body &Literal{

        This is an automatic earthquake solution from the

        Alaska Earthquake Information Center.

        Location and magnitude estimates are subject to change

        upon review of a human analyst.

        Please DO NOT DISSEMINATE this automatic solution.

        Contact the Alaska Earthquake Information Center

        for updated, analyst-reviewed information.

        Lat:    %{lat}

        Lon:    %{lon}

        Depth:  %{depth} km

        Time:   %{gmt_time}

        Magnitude: %{email_mag}

        %{ndef} phases used in solution

        This earthquake was located in %{grname}:

                %{nearest(1)}

                %{nearest(2)}

                %{nearest(3)}

        For more information contact the

        Alaska Earthquake Information Center

        at 907-474-7320

                }

                recipients &Arr{

                        duty@giseis.alaska.edu   0

                }

        }
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# Trigger conditions for non-AEIC cell phone notifications

        aeic_outside_cell    &Arr{

                trigger_condition       &Literal{

                        ( ndef >= 15 && ml >= 4.5 && %{in(Mainland Alaska)} && review == NULL ) ||

                        ( ndef >= 15 && ml >= 4.5 && %{in(South-east Alaska)} && review == NULL ) ||

                        ( ndef >= 15 && ml >= 5.5 && %{in(Eastern Aleutians)} && review == NULL ) ||

                        ( ndef >= 15 && ml >= 5.5 && %{in(Central Aleutians)} && review == NULL ) ||

                        ( ndef >= 15 && ml >= 5.5 && %{in(Western Aleutians)} && review == NULL )

                }

                subject         AEIC Automatic EQ

                body            &Literal{

      %{beeper_mag} %{lat} %{lon} %{depth} km depth %{local_time} %{nearest(1)}

                }

                wait_ack        0

                ack_subject

                ack_body

                recipients      &Arr{

#                        9074607214@msg.acsalaska.com   0

# Chris Jonientz-Trisler

#                        4259857576@mmode.com           0

# Rod Combellick

                        9073784419@mobile.celloneusa.com   0

                }

        }

# Trigger conditions for non-AEIC e-mail notifications

       aeic_auto_email    &Arr{

                trigger_condition &Literal{

                        ( ndef >= 15 && ml >= 4.0 && %{in(Mainland Alaska)} && review == NULL ) ||

                        ( ndef >= 15 && ml >= 4.0 && %{in(South-east Alaska)} && review == NULL ) ||

                        ( ndef >= 15 && ml >= 5.0 && %{in(Eastern Aleutians)} && review == NULL ) ||

                        ( ndef >= 15 && ml >= 5.0 && %{in(Central Aleutians)} && review == NULL ) ||

                        ( ndef >= 15 && ml >= 5.0 && %{in(Western Aleutians)} && review == NULL )

                }

                wait_ack        0

                ack_subject

                ack_body

                subject         AEIC AUTOMATIC EQ: MAG %{ml} %{subj_time} UT, %{grname}

                body &Literal{

        This is an automatic earthquake solution from the

        Alaska Earthquake Information Center.

        Location and magnitude estimates are subject to change

        upon review of a human analyst.

        Please DO NOT DISSEMINATE this automatic solution.

        Contact the Alaska Earthquake Information Center

        for updated, analyst-reviewed information.

        Lat:    %{lat}
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        Lon:    %{lon}

        Depth:  %{depth} km

        Time:   %{gmt_time}

        Magnitude: %{email_mag}

        %{ndef} phases used in solution

        This earthquake was located in %{grname}:

                %{nearest(1)}

                %{nearest(2)}

                %{nearest(3)}

        For more information contact the

        Alaska Earthquake Information Center

        at 907-474-7320

                }

                recipients &Arr{

                        Gary_Brown@ak-prepared.com   0

                        nymandj@djna.com   0

                        pheuslr@usgs.gov 0

                        rod@dnr.state.ak.us 0

                        tneal@usgs.gov 0

                        wcatwc@noaa.gov 0

                        guy@giseis.alaska.edu 0

                        scott@giseis.alaska.edu 0

                        mitch@giseis.alaska.edu 0

                        jpdixon@usgs.gov 0

steve.mcnutt@gi.alaska.edu 0

estes@gi.alaska.edu 0

                }

        }

    }

}

placedb /iwrun/op/params/alarm_regions/alarm_regions

placedb_branchcut_deg 360

max_ack_wait_sec 18000

alarm_dbfilenames %Y/%j/alarmid_%{alarmid}.%Y:%j:%H:%M:%S

pf_revision_time 1138650179
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10.6. Duty Laptop Features.

- Duty laptop MAC is to be used for the holiday and weekend event checks and earthquake alarm

response. It has alarm account set up for the beeper duty tasks (password ). Admin
account has the same password as alarm. Individual user accounts have password and

can be used for customizing your account and storing your personal preferences.

- You have to have high speed internet access to use this laptop for the beeper duty tasks. There

are some differences in how response software works depending on your internet provider.

Currently, GCI seems to be working better than ACS. See “Earthquake Response Procedure”
section for details.

- All standard tools, such as mail and internet browser, can be accessed by moving cursor into the

right screen margin.

- Programs and files that are used for the beeper duty tasks have shortcuts on the desktop (for

example, Help file, X11 icon, VPN Client icon, Resources folder).

- Mail tool opens with the dutylap e-mail account, password .

- Help file has some useful information on how to log into GI VPN and then into the seislab net-

work.

- Resources directory has some information in it too, such as response manual, contact list, inten-

sity scale, etc. You may add more resources to this directory.

- Safari is the internet browser. It has a couple of frequently used tabs, such as AEIC recenteqs
page and the USGS Did You Feel It page for Alaska.

- One thing to remember - each window has to be activated before you can do anything in it.

- Generally, do not leave duty_dbevents running continuously unless you have unlimited internet

access.

- VPN Client will disconnect whenever laptop lead is closed.

- One more thing to remember, dbpick window will not open automatically when you click first

time on the “Waveforms” button in dbloc2 window. You need to open dbpick window manu-

ally from smartpick window and then click again on “Waveforms” button to bring up the

waveforms for this particular event.

- And lastly, “Control-3” Framemaker macro does not work properly from dutylap over the inter-

net connections from outside the GI. See “Response Procedures” section for detailed descrip-

tion of what needs to be done to save and print files manually.
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10.7. E-fax Settings.

Electronic fax services are provided by DataOnCall company through a special AEIC

account. Our account can be accessed at: http://www.dataoncall.com
Username: aeicinfo, password: DQr7t92v, service type: UniFax

How it works: we send e-mail with info release as PDF attachment to the list of recipients at

DataOnCall, who then faxes it for us. List of recipients is specified in aeic_release.pf parameter

file as fax_release_recipient parameter. Only e-mails from specified accounts are accepted by

UniFax. These are entered through Setting/Outbound Settings option in UniFax. Currently it con-

tains all giseis.alaska.edu accounts for beeper duty personnel as well as alarm and dutylap
accounts. This needs to be updated in case of the personnel changes. All settings are specifically

tuned for faxing earthquake information releases. It does not fax e-mail body, only attachment.

This is the list of current fax recipients:

Table 8: Fax recipients of AEIC earthquake information releases.

# Organization Fax Number Telephone Number

1 AK DEC 907-269-3061 907-269-3061

2 AK DES 907-428-7095 907-428-7000

3 APRN 907-550-8402 907-277-2776

4 AK DGGS Bank Bldg 907-451-5050 7147

5 AK DNR Juneau 907-465-3886 907-465-2400

6 Governor Juneau 907-465-3532 907-465-3500

7 AK Governor Fairbanks 907-451-2858 451-2920

8 Associated Press 907-274-2189 907-272-7549

9 AVO Anchorage 907-786-7425 907-786-7456

10 ATWC 907-745-6071 907-745-4212

11??? EPA 703-557-0243 703-349-8970

12 Fairbanks Daily News 907-452-7917 456-6661

13 KTOO Juneau 907-586-3612 907-586-1670

14 KUAC 907-474-5064 7491

15 Geology & Geophysics 907-474-5163 7565

16 Sen. Stevens – D.C. 202-224-2354 202-224-8479

17 Sen. Stevens – Fairbanks 907-451-7290 456-0261

18 USGS – Jack Townshend 907-456-0356 7626

19 USGS – HVO 808-967-8890 808-967-7485

20 USGS – Menlo Park 650-329-5163 415-329-5227

21 Copper Valley Electric Assoc. 907-835-5860 cannon@cvea.org

22 Bradley electric Plant 907-235-5413 907-235-4444

23 AEIC 907-474-5618 474-7320
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10.8. A Method for Using dbloc2 and dbpick.
by M. LaFevers, updated by T. Cox 3/14/2002

Many options are available using dbloc2 and dbpick. The purpose of this summary is only to get

you processing an alarm event with a minimum frustration level. Many of the options are left for

you to discover through practice. I will present these instructions with the intention that you wish

to process an alarm event. Routine processing requires a slightly different approach that is

addressed in the routine processing manual, soon to be implemented.

These instructions assume you have already started dbloc2 and are ready to process the alarm

event. This paper is divided into the following sections:

1.0 TO SEE WAVEFORMS
2.0 EDITING PICKS
3.0 ADDING PICKS TO AN AUTOMATIC LOCATION
4.0 LOCATING THE EVENT
5.0 THE CHECKER TOOL
6.0 ADDING AN ALARM EVENT WITH NO AUTOMATIC SOLUTION

In this paper, double quotes indicate a button, green text indicates an action, and mouse clicks are

assumed to be a left mouse click unless noted. Blue text indicates a program.

Getting Started
The dbchecker tool and the dbloc2 window are opened up with the first automatic location and

associated picks for you to observe. This event is ready for you to finalize.

1.0 TO SEE WAVEFORMS

Start by clicking the "Waveforms" at the bottom of the dbloc2 window. Be patient, it will take a

few seconds to completely load. A dbpick window and a smartpick window will open on your

other monitor. The waveforms you see are sorted by distance from hypocenter. If you do not see

picks, or the times in the dbpick window do not agree with dbloc2, click "Waveforms" again to

complete synchronization of dbloc2 with dbpick.

optional:

There are two command windows for dbpick. One is called simply smartpick. The other is called

smartpick_dbpick_(some number).

You may access this window to use the command line interface if desired. The commands are

listed on the dbpick man page.

2.0 EDITING PICKS

NOTE: picks can be finalized from any dbpick window you have open. Practice will help you

determine the fastest and most convenient time to edit picks.
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Click "display associated picked traces" in the smartpick buttons pane. This will update the

dbpick window with the waveforms used by the automatic location program and the associated

picks. You should now edit them to obtain a good solution.

On the left of the waveform window is the list of stations. Left click on the station code will high-

light or unhighlight that station. You can highlight as many as you want, 3 or 4 is good, up to 10

can be selected with good detail. Left click on "Traces", then "New Window" on the pull-down.

The highlighted stations and waveforms will come up on a new window. Alternative and quicker

option is to use right click on an arrival box and choose “Magnify” option to bring it in a smaller

new window.

Left click and hold on a phase will enable you to move the phase. Middle click on the phase will

access a pull-down menu of phase options. Left click will select a phase.

Right click will access a pull-down of delete or magnify a phase. Shift + left click will add an

error bar to the phase.

Shift + two right clicks anywhere on the waveforms (except on the phase flags) will draw a box

to expand the waveforms.

Shift + two left clicks will draw a box to compress the waveforms.

     **The size of the box you draw will determine how much the waveforms compress or expand

and the time required to display the trace. Note that the compression of the waveforms will also

change the effect of the error bar.**

Hold the middle mouse button down on any waveform will enable you to drag the waveform

screen. Left click will move waveforms to the left. Right click will move waveforms to the right.

**The proximity of the cursor to the center of the screen will determine how far the waveforms

will be moved.**

IF YOU MAKE A MISTAKE AT ANYTIME, DRAWING A BOX, OR WHATEVER, CLICK-

ING THE MIDDLE MOUSE WILL OFTEN CANCEL. This can be very effective.

Another method to edit a specific trace is to right click on the phase in the dbloc2 plate and select

"show this waveform". Then finalize the pick.

3.0 ADDING NEW PICKS TO AN AUTOMATIC LOCATION

Click the "Waveforms" button at the bottom of the dbloc2 screen. In the waveform window,

waveforms will display, sorted from the hypocenter of the event.

Add new picks by clicking "Add Arrivals". You can add a series of picks by using the right click

placing cursor at the point you want to add the phase. Left click will cancel “Add arrivals”.
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Place cursor on a new arrival, right click and choose “Magnify” option to bring it in a smaller

new window. Select the phase for each pick with cursor on the pick and the middle mouse button.

Then add an error bar.

If you have finalized all of the picks in the main dbpick window, you may click on "Further" in

the dbloc2 window to advance to the next set of waveforms moving away from the hypocenter.

Note on adding phases:
You can set a default phase in the smartpick buttons pane. The buttons are:

"set default phase p" and "set default phase s"

4.0 LOCATING THE EVENT

You may notice that the phases you have added are greyed out in the dbloc2 window. You can left

click on each phase to enable the locator to use it, OR, you may draw a box around several picks

to enable them using the left mouse button, OR, you may click the "Select All" button if you

want to use all of the picks in the window for the location (inconvenient if there are phases from

another event in the pane).

Velocity model options:
Different regional velocity models are available for locating earthquakes. Use scak and northak

for the region south and north of 62.5N, respectively. gulfak should be used for events in the Gulf

of Alaska. If none of these models work to your satisfaction, you may use ttlvz/iasp91 model.

These options are located in the bottom third of the dbloc2 window. Change with a left click on

the pull-down menu. Default is tt1dcvl/scak model.

When the proper algorithm is selected for your event, click "Locate" at the bottom of the screen.

Depending on the size of the event and number of stations used, the location program can take up

to five minutes to do its job.

Observe your solution, noting error is displayed as an sdobs. Also note the station list and associ-

ated phases. These are updated every time you click "Locate". The number next to the station

code is distance from hypocenter in degrees. The number and arrow next to the phase represent

time residuals in seconds.

If your location is acceptable, you must select "Delete" by the defunct locations, and "Keep" for

the desired location. Also click the "Prefor" diamond to highlight it. You are able to keep other

solutions for the event by selecting "Chop" instead of delete, but make sure to click the "Prefor"
diamond for the most usable one.

If you need to stop the program before finishing the event, you must finalize the location for the

current event as described above, then select "File" then "Quit". Your location will be saved.

When you return at a later time and restart dbloc2, the program will resume at the same place you

stopped.
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5.0 ADDING AN ALARM EVENT WITH NO AUTOMATIC SOLUTION

Occasionally, the alarm may be set off but no event shows up in the database such as a far away

Aleutian event or sometimes an extremely northern AK event. These situations are difficult to deal

with, but a method has been developed.

1. First make sure that 10 minutes have passed with still no event showing up in the wormwatch
event list. Building an event from station triggers does take some time for the automatic system to

accomplish. If still no event is listed after 10 minutes and you have evidence that it was not a false

alarm, continue with the following.

2. Since the alarm went off, you have some reference to the time it occurred, such as the pager

readout, or the alarm triggering statistics on the screen above the EVA adjustment panel. Note the

origin time and the station(s) that set off the alarm. Begin the alarm response as directed in the

response manual and continue to the point of selecting an event from the wormwatch event list
(the one with the map).

3. Select an event from the wormwatch event database with an origin time closest to the event you

need. This is probably the most recent event. If your event time is too close to UTC midnight to

have another event, try the last event from the previous day.

4. "Subset the event database" as when processing a normal alarm event and "relocate" to start

dbloc2.

Adding picks:
5. Click "Waveforms" to start smartpick/dbpick. Make sure the origin time in dbloc2 corre-

sponds with the waveform window time. If not click "Waveforms" again.

6. Here is where the method changes. In the lower right corner of smartpick, click "show station
with nearby stations". Then from the "station" button on the lower left of the smartpick win-

dow, select the offending alarm station from the pull-down menu. dbpick is smart enough to then

display the 30 closest stations to the alarm station. Scroll the waveform window to the time of the

earthquake to make picks.

Get a location:
7. In the dbloc2 window, click "Ignore All" to grey out all picks from each of the two events and

avoid location confusion. Using the left mouse, draw a box around the picks that correspond with

the event you want.

8. Select the correct location program and the appropriate velocity model. Click the "Locate"
button. A new orid will come up in the location pane of dbloc2.

9. Finalize the location and continue the normal earthquake response.

Some hints for troubleshooting
If you are having difficulty, refer to the Response Software section of this manual. There you will

find information about the default directories setup by the response software to manually view

your work and methods to operate the alarm software with command line arguments.
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11. Contributors.

An earlier version of this manual (1999) was compiled by Trilby Cox (AEIC data analyst),

Martin LaFevers (AEIC data manager and data analyst) and Kent Lindquist (AEIC seismologist).

Most of the later modifications and additions were made by Natalia Ruppert (AEIC seismologist).

Some assistance was provided by Lily Wong (AEIC data analyst). Modified Mercalli Intensity

scale was produced by Artak Martirosyan (AEIC seismologist).

This document lives in

/Seis/beeper_duty/response_manual/aeic_beeper_duty_manual.fm
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